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OfficeLink Overview

Viewing reports in Microsoft Excel

Creating personalized letters using OfficeLink

OfficeLink templates for personalized letters

AccountEdge OfficeLink allows you to automatically create word processing and spreadsheet documents
using AccountEdge data. You must be using OfficeLink-compatible word processing and spreadsheet
programs.

These products are compatible with OfficeLink:

Microsoft Excel 98●   

Microsoft Word 98●   

Viewing reports in Microsoft Excel

While AccountEdge provides a wide range of reports and graphing tools, there may be times when you'll find
it more convenient to use Microsoft Excel to create what-if scenarios, budgets and the like. With OfficeLink,
you can transfer AccountEdge reports to Excel as easily as you can print them.

All the components you need to use OfficeLink are installed automatically; no additional steps are required.

Click below for the step-by-step procedure:

To view AccountEdge reports in Excel

Modifying OfficeLink templates for Microsoft Excel

To display an AccountEdge report in Microsoft Excel, AccountEdge uses a set of special Excel templates,
which are installed when you indicate that you use Excel during the AccountEdge installation process. Each
Excel template is associated with a specific AccountEdge report. You can modify these templates, if you
wish.

If you accidentally delete an OfficeLink template for your Excel reports or word processing program's letters,
you can recreate the missing template by reinstalling the AccountEdge program files. Any missing templates
will be added when you reinstall.

Any templates you've modified won't be replaced when you reinstall AccountEdge. If you wish to replace a
modified template when you reinstall AccountEdge, you must first rename or delete the template you
modified. (Refer to the documentation that accompanied your computer for information about renaming and
deleting files using your computer's operating system.)

Click below for the step-by-step procedure:

To modify OfficeLink templates for Microsoft Excel

Creating personalized letters using OfficeLink

From time to time, you may need to send a letter to a customer, reminding him that his payment is late, or
perhaps to tell a customer the items she's ordered are back ordered and will be delayed by a few days.
Using OfficeLink, it's easy to create letters for a single person or several companies-the only requirement is
that they have cards in your AccountEdge Card File.

In order to use OfficeLink, you must also be using an OfficeLink-compatible word processing program. (See
OfficeLink Overview for a list of compatible programs.)



Even if you haven't installed OfficeLink, you can create a "mail-merge" file that can be used with your word
processing program to create personalized letters. This process is more time-consuming, however. We
recommend that you take advantage of OfficeLink's capabilities if you can. If you choose not to use
OfficeLink, see Exporting data from MYOB AccountEdge for information about creating an export file of
AccountEdge information that can be mail-merged into letters and other documents.

AccountEdge provides a number of letter templates for you to use. If you wish to make permanent
modifications to the templates, see OfficeLink templates for personalized letters and consult the
documentation for your word processing program for instruction on doing so.

Using OfficeLink, you can send personalized letters to any person or company for whom you've created a
card using the Card Information window. You may find this handy for writing collection letters, apologies or
notices that your customer's items have been back ordered.

You can also view a list of all your unpaid receivables-that is, the sales you've entered in AccountEdge that
your customers haven't fully paid yet. When you've finished viewing the information, you can create
collection letters to send to customers whose payments are overdue.

Click below for the step-by-step procedures:

To send personalized letters to multiple people in your Card File

To send personalized letters to a single person or company

To send personalized letters to customers who have unpaid invoices

OfficeLink templates for personalized letters

When you create personalized letters using OfficeLink, you must choose a template for the letter you're
creating for the customers you select.

Changing the OfficeLink templates

The OfficeLink templates are specially designed to work with your AccountEdge data and your word
processing software to create personalized letters. Special entries, known as field codes, have been inserted
in these templates to ensure your AccountEdge data appears in the proper places in your letters. These field
codes are similar, but are not the same, as the typical mail-merge field codes that you would normally work
with in Microsoft Word. As a result, we recommend that you don't make changes to any of the field codes in
your OfficeLink templates. Also, if you plan to change your templates, we suggest that you first learn about
how your word processing program works with templates.

In each template, the format for each AccountEdge OfficeLink field code is text surrounded by double
brackets, like this:

[[Name]]

If you intend to manually add or change any OfficeLink field codes, be sure the codes use double brackets in
this manner.

Click below for the step-by-step procedure:

To choose an OfficeLink template for personalized letters

AccountEdge fields that can be merged into OfficeLink

To view OfficeLink field codes

Removing prompts for your name and title from OfficeLink templates

When you use OfficeLink to print mail-merge letters using Microsoft Word, you'll be prompted to enter your
name and title in a dialog box when the letters are created. Your entries will appear at the end of your



letters. If you're the only person who prints mail-merge letters, however, you may wish to remove these
prompts and place your name and title in the letter templates you use most often.

Click below for the step-by-step procedure:

To modify Microsoft Word templates

OfficeLink Overview
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Important note about changing templates! You must have extensive knowledge about Word templates
to use the information we've provided here. If you don't feel comfortable with this information, we strongly
encourage you to enlist some assistance from someone who is more knowledgeable about templates, such
as a Certified Consultant.



To view AccountEdge reports in Excel

If you haven't already read the OfficeLink Overview, see Viewing reports in Microsoft Excel for more
information.

The Index to Reports window should be displayed.

Highlight the report you want to display in Excel.1.  

Click Filters to limit the amount of information that appears on the report. The Report Filters window
appears, and you can specify the information you want to see on the report. Click OK.

Click the Excel button at the bottom of the Index to Reports window. The report will appear in an
Excel worksheet.

2.  

(If you want to view the information on the report in AccountEdge before opening Excel, click the Display
button, rather than the Excel button; the report will appear in AccountEdge's Screen Reports window. When
you're ready to view the report in Excel, click the Excel button in the Screen Reports window.)

In Excel, make any changes you like to the report information.3.  

To view AccountEdge reports in Excel

© MYOB Limited. All rights reserved.

Note: If you want to view the Cash Flow Analysis Report in Excel In order to view the AccountEdge
Cash Flow Analysis report in Excel, you must first display the Cash Flow Worksheet. If you choose the Cash
Flow Analysis report in the Index to Reports window, then click Excel, a message will appear to alert you
about this requirement. Click OK and the Cash Flow Worksheet window will be displayed for you
automatically. Click the Analyze Cash Needs button in that window, then click the Excel button in the Index
to Reports to view the report in Excel.

file:///C|/^^^^^US 10 PDFs/_Mac/PDFOutput/640000c.fm


To modify OfficeLink templates for Microsoft Excel

If you haven't already read the OfficeLink Overview, see Modifying OfficeLink templates for Microsoft Excel
for more information.

Click below for a list of AccountEdge reports and their corresponding Excel templates:

General Ledger Tab

Checkbook Tab

Sales Tab

Time Billing Tab

Purchases Tab

Payroll Tab

Inventory Tab

Card File Tab

To modify OfficeLink templates for Microsoft Excel
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Warning: Use caution when modifying AccountEdge's Excel templates! If you modify the Excel
templates for your AccountEdge reports, be sure that you do not move the [[Tbl:Body Table]] field. This
field must be located in Column B, row 15, in order for each report's total amounts to be calculated
correctly. If you move [[Tbl:Body Table]], the totals will be inaccurate.

Also note that you cannot directly reference a specific piece of data within a report when creating additional
calculations on your report data. This is because Excel will push the reference field you create to a field
below the end of the report body when the report is imported into Excel. As an alternative, we suggest that
you either create a macro that will be calculated after the report is imported or place your reference field on
a separate spreadsheet that will be updated after the report is imported.



General Ledger Tab

Report Template File Name
Account History (OfficeLink) accthist.xlt
Account Inquiry acctinq.xlt
Balance Sheet balsht.xlt
Balance Sheet (Spreadsheet) balshts.xlt
Balance Sheet (Budget Spreadsheet) balshtbs.xlt
Balance Sheet (Last Year Analysis) balshtla.xlt
Balance Sheet (Budget Analysis) balshtba.xlt
Chart Of Accounts (Summary) coasum.xlt
Chart Of Accounts (Detail) coadet.xlt
Currency List curlst.xlt
Currency Realized Gain/Loss curre.xlt
Currency Unrealized Gain/Loss curunre.xlt
General Journal genjrl.xlt
Job Activity (Summary) jobacts.xlt
Job Activity (Detail) jobactd.xlt
Job Budget History (OfficeLink) jobbudhi.xlt
Job History (OfficeLink) jobhist.xlt
Job Inquiry jobinq.xlt
Job Profit & Loss jobpl.xlt
Job Reimbursable Expenses jobreexp.xlt
Jobs (Budget Analysis) jobba.xlt
Jobs List joblist.xlt

Profit & Loss pl.xlt
Profit & Loss (Spreadsheet) pls.xlt

Profit & Loss (Budget Spreadsheet) plbs.xlt
Profit & Loss (with Year to Date) plytd.xlt

Profit & Loss (with Last Year) plly.xlt
Profit & Loss (% Sales Analysis) plsa.xlt

Profit & Loss (Last Year Analysis) pllya.xlt
Profit & Loss (Budget Analysis) plba.xlt

Recurring General Journal Entry recgj.xlt
Session Report session.xlt

Trial Balance (Summary) trlbas.xlt
Trial Balance (Detail) trlbald.xlt

OfficeLink Templates - General Ledger Tab
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Checkbook Tab

Report Template File Name
Cash Disbursements Journal cdjrnl.xlt
Cash Flow Analysis cashflw.xlt
Cash Receipts Journal crjrnl.xlt
Checkbook Register chkbkreg.xlt
Reconciliation Report reconcil.xlt
Bank Deposit bdr.xlt
Recurring Checks recchk.xlt

Recurring Deposits recdep.xlt
To Do List (Recurring Transactions) tdlrectn.xlt

OfficeLink Templates - Checkbook Tab
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Sales Tab

Report Template File Name
Aged Receivables (Summary) agedars.xlt
Aged Receivables (Detail) agedard.xlt
Analyze Sales (Item) zsalit.xlt
Analyze Sales (Item - FY Comparison) zsalitly.xlt
Analyze Sales (Item Spreadsheet) zsalits.xlt
Analyze Sales (Activity) zsalac.xlt
Analyze Sales (Activity - FY Comparison) zsalacly.xlt
Analyze Sales (Activity Spreadsheet) zsalits.xlt
Analyze Sales (Customer) zsalc.xlt
Analyze Sales (Customer - FY Comparison) zsalcly.xlt
Analyze Sales (Customer Spreadsheet) zsalcs.xlt
Analyze Sales (Salesperson) zsalsp.xlt
Analyze Sales (Salesperson - FY Comparison) zsalsply.xlt
Analyze Sales (Salesperson Spreadsheet) zsalsps.xlt
Customer Payment (Closed Invoices) custpyh.xlt
Customer Payments (Salesperson) custpysp.xlt
Customer Reimbursable Expense custrexp.xlt
Invoice Inquiry invinq.xlt
Receivables Reconciliation (Summary) arrecsum.xlt

Receivables Reconciliation (Detail) arrecdtl.xlt
Recurring Sales Templates recsale.xlt

Referral Source inqsrc.xlt
Sales & Receivables Journal salejrnl.xlt
Sales (Customer Summary) salcusts.xlt

Sales (Customer Detail) salcustd.xlt
Sales History by Customer (OfficeLink) salhiscu.xlt

Sales History by Salesperson (OfficeLink) salhissp.xlt
Sales (Salesperson Summary) salsps.xlt

Sales (Salesperson Detail) salspd.xlt
Sales (Activity Summary) salacts.xlt

Sales (Activity Detail) salactd.xlt
Sales (Item Summary) salitms.xlt

Sales (Item Detail) salitmd.xlt
Sales Register (All Sales) srall.xlt

Sales Register (Closed Invoices) srclol.xlt
Sales Register (Open Invoices and Orders) srinvor.xlt

Sales Register (Quotes) srquo.xlt
Sales Register (Returns and Credits srcred.xlt

Sales Tax (Summary) saltxs.xlt
Sales Tax (Summary - Cash) saltxsc.xlt

Sales Tax (Detail) saltxd.xlt
Sales Tax (Detail - Cash) saltxdc.xlt

Sales Tax Exceptions (Checkbook) tcect.xlt
Sales Tax Exceptions (Sales/Purchases) tceit.xlt

Tax Code List txcodlst.xlt
To Do List (Receivables) tdlar.xlt

To Do List (Recurring Sales) tdlrcsal.xlt
To Do List (Orders to be Shipped & Received) tdlordrs.xlt

OfficeLink Templates - Sales Tab
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Time Billing Tab

Report Template File Name
Activity List actlist.xlt
Activity Log Detail actlogdl.xlt
Activity Log Diary actlogdy.xlt
Activity Slip (Activity Detail) asactdet.xlt
Activity Slip (Activity Summary) asactsum.xlt
Activity Slip (Customer Detail) ascusdet.xlt
Activity Slip (Customer Summary) ascussum.xlt
Activity Slip (Employee Detail) asempdet.xlt
Activity Slip (Employee Summary) asempsum.xlt

Hourly Productivity (Detail) hrprodd.xlt
Hourly Productivity (Summary) hrprods.xlt

Rate Exceptions rateexcp.xlt

OfficeLink Templates - Time Billing Tab
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Purchases Tab

Report Template File Name
Aged Payables (Detail) agedapd.xlt
Aged Payables (Summary) agedaps.xlt
Analyze Purchases (Item Spreadsheet) zpurits.xlt
Analyze Purchases (Vendor FY Comparison) zpurvly.xlt
Analyze Purchases (Vendor Spreadsheet) zpurvs.xlt
Analyze Purchases (Vendor) zpurv.xlt
Bill Inquiry poinq.xlt
Payables Reconciliation (Detail) aprecond.xlt
Payables Reconciliation (Summary) aprecons.xlt
Purchase History by Vendor (OfficeLink) purhisv.xlt
Purchases & Payables Journal papjrnl.xlt
Purchases (Item Detail) puritmd.xlt
Purchases (Item Summary) puritms.xlt
Purchases Register (All Purchases) prall.xlt
Purchases Register (Closed Bills) prclol.xlt
Purchases Register (Open Bills and Orders) prbilor.xlt
Purchases Register (Quotes) prquo.xlt
Purchases Register (Returns and Debits prcred.xlt
Purchases (Vendor Detail) purvendd.xlt
Purchases (Vendor Summary) purvends.xlt

Recurring Purchase Templates recpo.xlt
To Do List (Expiring Discounts) tdlexpd.xlt

To Do List (Payables) tdlap.xlt
To Do List (Recurring Purchases) tdlrecpr.xlt

Vendor Payment History vdrpyh.xlt
Vendor Payments vdrpyt.xlt

OfficeLink Templates - Purchases Tab
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Payroll Tab

Report Template File Name
940 Report 940.xlt
941 Report 941.xlt
Accrual Balance (Summary) aclbals.xlt
Accrual Balance (Detail) aclbald.xlt
Employee Payroll List empyrlst.xlt
Payroll Activity (Summary) payacts.xlt
Payroll Activity (Detail) paycatd.xlt
Payroll Category Inquiry paycatiq.xlt
Payroll Earnings pradv.xlt
Payroll Journal payjrnl.xlt
Payroll Register (Summary) payregs.xlt
Payroll Register (Detail) payregd.xlt
Payroll Summary paysum.xlt
Quarterly Tax Totals qtrtt.xlt
Recurring Paychecks recpychk.xlt
Tax Detail (Employee) txdetemp.xlt
Tax Liabilities taxliab.xlt

OfficeLink Templates - Payroll Tab
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Inventory Tab

Report Template File Name
Analyze Inventory (Summary) zinvs.xlt
Analyze Inventory (Detail) zinvd.xlt
Auto Build autobld.xlt
Inventory Count Sheet invctst.xlt
Inventory Journal invjrnl.xlt
Item Sales History (OfficeLink) itemsalh.xlt
Items List (Summary) itmls.xlt
Items List (Detail) itmld.xlt
Price Analysis pricez.xlt
Price List (Summary) prclsst.xlt
Price List (Detail) prclsstd.xlt
To Do List (Stock Alert) tdlsa.xlt

OfficeLink Templates - Inventory Tab
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Card File Tab

Report Template File Name
Address List addlst.xlt
Card File (Summary) cfsum.xlt
Card File (Detail) cfdet.xlt
Card Inquiry cfinq.xlt
Contact Log clog.xlt
Identifiers ids.xlt
To Do List (Overdue Contacts) tdloc.xlt

OfficeLink Templates - Card File Tab
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To send personalized letters to multiple people in your Card File

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.

If you're not using OfficeLink, see Exporting data from MYOB AccountEdge for information on creating an
export file that can be used to create mail-merge letters.

The Forms Selection - Personalized Letters window should be displayed.

Make selections about the data you want to export and then click OK. The Review Cards Before
Exporting window appears.

1.  

All cards whose data fit the criteria you entered in the Personalized Letters window appear in the list
with a mark in their Export field.

2.  

If you don't want to export the data for a card, click the mark in its Export field to remove the mark.

Click Mail Merge.3.  

The Select From List window appears with a list of letter templates you can use to create
personalized letters for the customers you've selected.

4.  

Highlight the template you want, and click the Use Template button.

(See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.)

Your word processor will open, and a series of dialog boxes will appear, allowing you to enter
additional information that will appear in the letters. For all letters, you'll be asked to enter your
name and business title.

5.  

I f you're printing letters to alert your customers that some of their items are on back order, using the
BACKORD template, you also will be asked to indicate the items that are on back order.

If you enter multiple items, they will be printed in a column; to ensure that they appear properly, we
suggest that you make your entries in the dialog box in the following format:

#WP-FLO Floral Wallpaper

#WP-GEO Geometric Wallpaper

If you're printing letters to alert customers that the checks they used to pay you have bounced, using the
BOUNCED template, you'll be asked to specify the check number and the amount for each customer you've
selected.

When you've made all the entries required, the personalized letters for the customers you selected will be
displayed. You can edit these letters, if you like, or print them just as they are.

To send personalized letters to multiple people in your Card File

© MYOB Limited. All rights reserved.

Note: The items you enter in the dialog box will be used on all the letters you've selected You can
enter more than one item in the dialog box that appears when your word processing program is started. It's
important to note, however, that whatever entries you make in the dialog box will be used for every letter
you've selected. Using the example above, every customer you've selected will be told that their geometric
wallpaper and floral wallpaper are on back order.

If some customers have ordered another combination of items that are back ordered, you'll need to repeat
this procedure for those customers. Following our example, you might create one set of letters for people
who ordered geometric wallpaper, a second set of letters for those who ordered floral wallpaper, and a third
set of letters for those who ordered both types of wallpaper.
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To send personalized letters to a single person or company

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.

The Cards List window should be displayed.

Click on the name you want to highlight it.1.  

Click the Letter button at the bottom of the window.2.  

The Select From List window will appear with a list of letter templates you can use to create
personalized letters for the person or company you've selected.

3.  

Highlight the template you want, then click the Use Template button.

See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.

Your word processor will open, and a series of dialog boxes will appear, allowing you to enter
additional information that will appear in the letter. For all types of letters, you'll be asked to enter
your name and business title.

4.  

If you're printing a letter to alert your customer that some of their items are on back order, using the
BACKORD template, you also will be asked to indicate the items that are on back order.

If you enter multiple items, they will be printed in a column; to ensure that they appear properly, we
suggest that you make your entries in the dialog box in the following format:

#WP-GEO Geometric Wallpaper

#WP-FLO Floral Wallpaper

If you're printing a letter, using the BOUNCED template, to alert a customer that the check they used to pay
you has bounced, you'll be asked to specify the check number and the amount of the check that bounced.

When you've made all the entries required, the personalized letter for the customer you selected will be
displayed. You can edit this letter, if you like, or print it just as it is.

To send personalized letters to a single person or company
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Note: The items you enter in the dialog box will appear on all the letters you've selected You can
enter more than one item in the dialog box that appears when your word processing program is started. It's
important to note, however, that whatever entries you make in the dialog box will be used for every letter
you've selected. Using the example above, every customer you've selected will be told that their geometric
wallpaper and floral wallpaper are on back order.

If some customers have ordered another combination of items that are back ordered, you'll need to repeat
this procedure for those customers. Following our example, you might create one set of letters for people
who ordered geometric wallpaper, a second set of letters for those who ordered floral wallpaper, and a third
set of letters for those who ordered both types of wallpaper.
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To send personalized letters to customers who have unpaid invoices

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.

If you're not using OfficeLink, see page Creating personalized letters using exported data for information on
creating an export file that can be used to create mail-merge letters for your customers with unpaid
invoices.

The To Do List window should be displayed.

Click the A/R (Accounts Receivable) tab to display a list of all your unpaid receivables.1.  

If you want to view detail about a specific sale, click the zoom arrow to the left of the customer's
name.

2.  

Click the Action column for each customer in the list to whom you want to send a letter.3.  

Click the Mail Merge button at the bottom of the window.4.  

The Select From List window appears with a list of letter templates you can use to create
personalized letters for the customers you've selected. AccountEdge provides four templates for
collection letters. Highlight the template you want from the following list, and click the Use Template
button.

5.  

See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.

Your word processor will open, and a series of dialog boxes will appear, allowing you to enter your
name and business title.

6.  

When you've made all the entries required, the personalized letters for the customers you selected will be
displayed. You can edit these letters, if you like, or print them just as they are.

To send personalized letters to customers who have unpaid invoices
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To choose an OfficeLink template for personalized letters

If you haven't already read the OfficeLink Overview, see OfficeLink templates for personalized letters for
more information.

You must have extensive knowledge about Word templates to change your templates in AccountEdge. If you
don't feel comfortable with this information, we strongly encourage you to enlist some assistance from
someone who is more knowledgeable about templates, such as a Certified Consultant.

Choose a template from the list below:

Apology letter

Backorder letter

Blank letter

Bounced check letter

First collection letter

Second collection letter

Third collection letter

Final collection letter

Fax cover page

Resolution letter

Thank you letter

To choose an OfficeLink template for personalized letters
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Apology letter

Template names:

Apology Letter

Use this letter template to apologize for a problem your company has caused for a customer, and to assure
the customer that the problem will be addressed.

Infotech Consulting

254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Please accept my sincere apology, on behalf of InfoTech Consulting for the difficulties we've caused you.
We've made a sincere effort to address your problem, and we hope that you find the resolution satisfactory.
Please contact me directly if you have any remaining issues or questions; it's important to me that your
concerns are fully addressed.

Sincerely,

Mark Davidson
Vice President
Apology letter
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Backorder letter

Template names:

Backorder Letter

Use this letter template to let your customers know the items they've ordered are on back order and will be
shipped as soon as possible.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Thank you for the order you placed. Unfortunately, the following item(s) you've ordered are currently on
back order with our supplier:
We expect these items to arrive shortly, and we'll ship your order as soon as they do.
If you have any questions or you'd like to make a change to your order, please call us. We appreciate your
business, and we apologize for any inconvenience this delay causes you.

Sincerely,

Mark Davidson
Vice President
Backorder letter
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Blank letter

Template names:

Blank Letter

Use this letter format when none of the other AccountEdge templates meet your needs and you wish to write
your own letter. The following information for the selected person or company will appear in your word
processing document: contact name, company name, address, city, state, zip code and salutation. In
addition, your company name and address will appear at the top of the document.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, New Jersey 07860

Dear Dave:

_________________________________________________________

(Insert your own text here in this space of the Blank Template.)

_________________________________________________________

Sincerely,

Mark Davidson
Vice President

Blank letter
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Bounced check letter

Template names:

Bounced Check Letter

Use this letter template for customers whose payment checks have been returned to you marked "NSF"
(non-sufficient funds).

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Your bank has returned your check, number 5001, for $1,000 to us. The bank indicated that your account
doesn't have sufficient funds to pay the check.

In order for you to keep your account with us in good standing, it's important that you make payment
within 3 days. We ask that you use the enclosed envelope to make your payment., and we ask that you
make your payment using a certified check, money order or cashier's check. (If the overdraft occurred
because of a bank error, please simply send a replacement check.)

If you're unable to make a full payment or if you have questions about the returned check, please call
immediately. We will work with you, if need be, to find a solution that allows you to keep your good credit
standing with us.

Sincerely,

Mark Davidson
Vice President
Bounced check letter
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First collection letter

Template names:

Collection - First Letter

Use this letter template for customers whose accounts have become past due. This letter serves as a gentle
reminder to your customers to bring their account balance up to date.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Our records show that your current balance with us is $1,866.56, of which $1,866.56 is now past due. We
hope this is merely an oversight on your part. If you haven't already sent a payment for the past due
amount to us, please do so today. If a problem has arisen that we should be aware of, please call us
immediately to discuss it.

We value your business, and we'd like for you to resolve this issue as quickly as possible.

Sincerely,

Mark Davidson
Vice President
First collection letter
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Second collection letter

Template names:

Collection - Second Letter

This letter template expresses greater urgency than COLL_1ST and requests that your customer contact you
immediately.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
15 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Is there a reason we have not heard from you? Your overdue balance is now $1,866.56 and is long past
due. This is beginning to concern us. Please let us hear from you at once.

Sincerely,

Mark Davidson

Vice President
Second collection letter
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Third collection letter

Template names:

Collection - Third Letter

This letter template is similar to COLL_2ND, but expresses even greater urgency, and encourages the
customer to take action before his credit history is damaged.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

We have not yet received your overdue balance of $1,866.56. Please contact us immediately.

We'd like to continue thinking of you as a valued customer. We'd prefer not to damage our relationship by
turning your account over to a collection agency. However, we will do so if we don't receive payment from
you immediately.

If you've already sent the payment, please call us. If you haven't done so, please send your payment in full
today.

Sincerely,

Mark Davidson
Vice President
Third collection letter
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Final collection letter

Template names:

Collection - Final Letter

This letter template is the most strongly worded of the AccountEdge collection letters. It indicates that you
will turn the customer's account over to a collection agency if payment isn't made within a specified number
of days.

Infotech Consulting
254 Willow Street
Parsippany, New Jersey 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Despite our previous efforts to settle this matter, your account remains unpaid and is long overdue. Unless
we receive full payment of $1,866.56, we will turn your account over to our collection agency for collection.

As you know, such action is likely to damage your credit rating and your ability to do business with other
companies. We don't wish for that to happen. We've enjoyed doing business with you, but we really must
settle your account.

If you call me, we may be able to find a solution that allows you to make payment and avoid the
unpleasantness of the collection process. I urge you to call me today.

Please call today or make immediate payment in full. Otherwise, I will turn your account over to our
collection agency.

Sincerely,

Mark Davidson
Vice President
Final collection letter
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Fax cover page

Template names:

Fax Cover

Use this letter template to create a fax cover page for the people or companies you've selected. This page
includes room for a memo, should you wish to include one.

FAX Cover Page

To:
Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Fax:
973-555-2345

From:
Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

973-555-5555

Date:
10/4/00

Pages: _________

Memo:
(This is where you can add a memo should you wish to include one)

Fax cover page
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Resolution letter

Template names:

Complaint Resolution Letter

Use this letter format for customers who have questioned an amount on their monthly statement. This letter
indicates that you are looking into the matter and that you will credit the customer's account for the amount
in question while the matter is investigated.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Thanks for alerting us to your concerns about your statement. We are researching the changes on the
statement, and we expect to contact you shortly with a resolution to the problem. In the meantime, we've
credited your account for the amount in question.

Please feel free to call me if you have any further questions about this matter, or if I can assist you in some
other way.

Sincerely,

Mark Davidson
Vice President
Resolution letter
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Thank you letter

Template names:

Thank You Letter

Use this letter to thank new customers for their business.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Thanks for choosing us! We appreciate your business and the opportunity to serve you. We know you could
have chosen one of our competitors, and we're delighted and honored that you've chosen to work with us
instead. I trust we'll meet or exceed your expectations in the coming months and years.

Please call me if I can assist you in any way.

Sincerely,

Mark Davidson
Thank you letter
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AccountEdge fields that can be merged into OfficeLink

If you haven't already read the OfficeLink Overview, see Changing the OfficeLink templates for more
information.

Only a specific number of AccountEdge fields are available for use in the OfficeLink templates. You must
have extensive knowledge about Word templates to use the information we've provided here. If you don't
feel comfortable with this information, we strongly encourage you to enlist some assistance from someone
who is more knowledgeable about templates, such as a Certified Consultant.

The following AccountEdge fields can be merged into OfficeLink templates.

AccountEdge field Where the field is located in AccountEdge
[[Company]] Company Name field in the Company Information

window
[[Cadd1]] First line of the Address field in the Company

Information window
[[Cadd2]] Second line of the Address field in the Company

Information window
[[Cadd3]] Third line of the Address field in the Company

Information window
[[Cadd4]] Fourth line of the Address field in the Company

Information window
[[CPhone]] Phone Number field in the Company Information

window
[[Name]] Company Name field in the Card Information window

for companies; Last Name and First Name fields in the
Card Information window for individuals

[[Add1]] First line of the Address 1 field in the Card
Information window

[[Add2]] Second line of the Address 1 field in the Card
Information window

[[Add3]] Third line of the Address 1 field in the Card
Information window

[[Add4]] Fourth line of the Address 1 field in the Card
Information window

[[Add5]] Fifth line of the Address 1 field in the Card
Information window

[[City1]] The City field of the Address 1 field in the Card
Information window

[[State1]] The state field of the Address 1 field in the Card
Information window

[[ZIP1]] The zip code field of the Address 1 field of the Card
Information window

[[Sadd1]] First line of the Address 2 field in the Card
Information window (used for customers and vendors

only)
[[Sadd2]] Second line of the Address 2 field in the Card

Information window (used for customers and vendors
only)

[[Sadd3]] Third line of the Address 2 field in the Card
Information window (used for customers and vendors

only)
[[Sadd4]] Fourth line of the Address 2 field in the Card

Information window (used for customers and vendors
only)

[[Sadd5]] Fifth line of the Address 2 field in the Card
Information window (used for customers and vendors

only)
[[City2]] The City field of the Address 2 field in the Card

Information window (used for customers and vendors
only)



[[State2]] The state field of the Address 2 field in the Card
Information window (used for customers and vendors

only)
[[ZIP2]] The zip code field of the Address 2 field in the Card

Information window (used for customers and vendors
only)

[[Phone1]] Phone #1 field in Address 1 in the Card Information
window

[[Phone2]] Phone #2 field in Address 1 in the Card Information
window

[[Fax]] Fax field in Address 1 in the Card Information window
[[Salutation]] Salutation field in Address 1 in the Card Information

window
[[Contact]] Contact field in Address 1 in the Card Information

window
[[Balance]] The balance, in dollars, of customers' and vendors'

accounts, as calculated by AccountEdge
[[Overdue]] The overdue balance, in dollars, of customers and

vendors, as calculated by AccountEdge

AccountEdge fields that can be merged into OfficeLink
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To view OfficeLink field codes

If you haven't already read the OfficeLink Overview, see OfficeLink templates for personalized letters for
more information.

In Microsoft Word, you can choose Options from the Tools menu to display the Options window. To view field
codes, mark the Field codes option and click OK.

To view OfficeLink field codes
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To modify Microsoft Word templates

If you haven't already read the OfficeLink Overview, see Removing prompts for your name and title from
OfficeLink templates for more information.

Start Microsoft Word.1.  

Choose Open from the File menu. The Open dialog box will appear.2.  

Using this dialog box, locate your AccountEdge software folder, then locate the Letters folder within
it. Display the contents of this folder.

3.  

Choose All Files from the Files of Type field. All your OfficeLink letter templates will appear.4.  

Highlight the template you wish to modify, and click Open. The template you selected will open.5.  

If you're unsure about which template you want, see To choose an OfficeLink template for personalized
letters for descriptions of OfficeLink letter templates.

Choose Options from the Tools menu; the Options window will appear.6.  

Click the View tab. If the Field Codes option isn't marked, mark it, then click OK. When this option is
marked, a number of hidden fields will appear in your template.

7.  

Locate the following fields at the bottom of the template, and delete them:8.  

{ FILLIN "Enter your Name:"\o }
{ FILLIN "Enter your title:"\o }

Type your name and title at the bottom of the letter.9.  

Choose Save from the File menu.10.  

To modify Microsoft Word templates
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